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Bab I Pengenalan OpenOffice.org

BAB I

PENGENALAN OPENOFFICE.org

1.1. Pengenalan OpenOffice.org

Open Source adalah software dengan kriteria sebagai berikut :

1. Distribusi  ulang  yang  tidak  terbatas.  Software  open  source  dapat  didistribusikan 

ulang baik secara gratis maupun dengan mengambil keuntungan.

2. Source code. Sumber kode dari software harus tersedia

3. Pekerjaan  lanjutan.  Source  code  dapat  digunakan  untuk  membuat  pekerjaan 

berikutnya.

OpenOffice.org adalah sebuah paket aplikasi perkantoran berkode sumber terbuka (open 

source)  yang  dapat  diperoleh  secara  gratis.  Paket  tersebut  termasuk  komponen-

komponen pengolah kata, pengolah angka, presentasi, drawing, dan gudang data.

OpenOffice.org  dapat  berjalan  di  platform mulai  dari  Windows 95  atau  lebih  baru, 

Linux,  Solaris  dan  Mac OS X.  OpenOffice.org  menyediakan banyak  bahasa  seperti 

Perancis, Spanyol, Portugis, China (tradisional dan simplified),  Italia,  Jepang, Hindi, 

Roma,  Thai,  Danish,  Belanda,  Indonesia  dan  sebagainya.  Tersedia  dukungan  teknis 

yang berkualitas tinggi dan gratis berkat mailing list dan forum yang dijalankan oleh 

sukarelawan.

Tabel 1.1  Paket dalam aplikasi OpenOffice.org :

Aplikasi OpenOffice.org

Pengolah kata Word Processor

Pengolah angka Spreadsheet

Paket presentasi Presentation

Sistem manajemen database Database

Drawing Draw

1
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1.2. Kelebihan OpenOffice.org

Berikut kelebihan-kelebihan OpenOffice.org :

1. Tidak ada biaya lisensi

OpenOffice.org bebas digunakan dan bebas didistribusikan.

2. Open source

Pengguna dapat mendistribusikan, menyalin serta mengubah perangkat lunak sesuai 

dengan kebutuhan.

3. Cross-platform

OpenOffice.org dapat dijalankan diberbagai  platform hardware dan sistem operasi 

seperti MS. Windows, Mac OS X dan Linux.

4. Dukungan multibahasa

OpenOffice.org mendukung berbagai bahasa (lebih dari 40 bahasa), ejaan, hipenasi 

dan  thesaurus. Selain itu juga terdapat layout bahasa  Complex Text Layout seperti 

Hindi dan Arabic.

5. User interface yang konsisten

Semua komponen memiliki  “look and feel” yang serupa,  sehingga memudahkan 

dalam penggunaan dan penguasaan perangkat lunak.

6. Terintegrasi

Seluruh komponen OpenOffice.org saling terintergrasi satu sama lain.

7. Granulariti

Jika mengubah opsi maka akan mengubah seluruh komponen. Walau begitu,  opsi 

dapat diatur pada setiap komponen atau dokumen.

8. Kompatibilitas file

OpenOffice.org  mempunyai  kemampuan  untuk  mengekspor  dokumen  ke  format 

PDF dan flash. Selain itu juga dapat digunakan untuk membuka dan menyimpan file 

dalam format MS. Office, HTML, XML, Wordprefect dan Lotus123

9. Tidak terpaku pada satu vendor

OpenOffice.org menggunakan OpenDocument, file format XML yang dikembangkan 

sebagai standar industri oleh OASIS  (Organizations the Advancement Information  

Standard). Sehingga file-file dapat dengan mudah dibuka dan dibaca oleh teks editor 

lain.

2
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10.Berkontribusi

Semua  pengguna  dapat  terlibat  dalam  proses  pengembangan  dan  perbaikan 

perangkat lunak. Hal ini dilakukan dengan bergabung ke dalam komunitas.

1.3. Modul dalam OpenOffice.org

Aplikasi office suite OpenOffice.org terdiri dari 6 modul yaitu :

1. Writer (Pengolah Kata)

Writer adalah modul yang digunakan untuk mengolah kata. Dokumen yang dapat dibuat 

dengan writer diantaranya naskah, surat, buku, laporan, berita dan lain-lain. Format file 

pada writer default-nya bereksistensi ODT namun dapat juga disimpan dengan format 

lain seperti DOC, HTML, XHTML dan lain-lain.

2. Calc (Pengolah Angka)

Calc adalah modul yang digunakan untuk membuat lembar kerja. Dengan calc dapat 

menganalisis,  membuat  grafik  chart  atau  membuat  keputusan  yang  dibantu  oleh 

berbagai  fungsi  untuk  pengambilan  keputusan.  File  lembar  kerja  yang  disimpan 

berekstensi ODS, namun calc dapat juga membaca dan menyimpan format file dengan 

ekstensi XLS, CSV, DBF, HTML dan lain-lain.

3. Impress (Presentasi)

Impress adalah modul untuk membuat dokumen presentasi. Impress dilengkapi dengan 

tool presentasi multimedia antara lain efek khusus, animasi dan gambar. File presentasi 

secara default bereksistensi ODP namun bisa juga membuka dan menyimpan dengan 

ekstensi lain seperti PPT dan dapat diekspor menjadi file Macromedia Flash (SWF)

4. Base (Basis Data)

Base adalah  modul  yang  digunakan  untuk  membuat  aplikasi  basis  data  dengan 

antarmuka yang menarik. Kemampuan base setara dengan MS. Access sehingga dapat 

digunakan untuk membuat  form, report, query, table, view  dan relasi.  Database yang 

dapat  dimanfaatkan  oleh  base  cukup  banyak  seperti  HSQLDB  (default  database 

engine), dBase, Ms. Access, MySQL dan lain-lain.

5. Draw (Menggambar)

Draw adalah modul yang digunakan untuk menggambar. Gambar yang dihasilkan bisa 

berupa  diagram atau  flowchart   dan  dapat  digunakan  untuk  menggambar  3-D.  File 
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gambar  yang  dihasilkan  dapat  disimpan  dengan  format  sekitar  ada  20  format  file 

termasuk PNG, HTML, PDF dan Flash. Untuk membuat gambar pada modul.

6.  OpenOffice.org lainnya dapat mengaktifkan dengan menggunakan tool dari toolbar  

Drawing.

7. Math (Formula)

Math adalah editor formula atau rumus. Modul ini digunakan untuk membuat rumus 

kompleks yang terdiri dari simbol-simbol atau karakter-karakter yang tidak ada pada 

font standar.  Math  juga  dapat  diaktifkan  pada  modul  OpenOffice.org  lainnya  atau 

diaktifkan sebagai editor sendiri. File yang dibuat dapat disimpan dengan format standar 

MathML yang memudahkan dalam menyajikan formula  sebagai  halaman  web  atau 

untuk digunakan pada dokumen yang dibuat dengan perangkat lain.

4
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BAB II

OPENOFFICE.org WRITER

2.1. Antarmuka OpenOffice.org Writer

Antarmuka pada  OpenOffice.org  Writer  terdiri  dari  Title  bar,  Menu,  Toolbar,  Ruler, 

Area Kerja dan Status Bar.

2.1.1. Menu

Menu terletak pada bagian atas layar di bawah title bar. Menu utama terdiri dari File,  

Edit, View, Insert, Format, Table, Tools, Window dan Help. Seperti gambar dibawah :

Gambar 2.1 Menu OpenOffice.org

1. Menu File berisikan perintah-perintah yang berlaku pada seluruh dokumen seperti 

Save, Open, Close, Wizard, Print dan lain-lain.

2. Menu Edit berisikan perintah-perintah untuk penyuntingan dokumen seperti Undo, 

Find and Replace dan lain-lain.

3. Menu View berisikan perintah-perintah untuk mengontrol penampilan dokumen  

seperti zoom dan web layout.

4. Menu  Insert  berisikan  perintah-perintah  untuk  menyisipkan  elemen  dokumen  

seperti Header, Footer dan Picture.

5. Menu Format berisikan perintah-perintah untuk memformat dokumen seperti Style 

and formatting, Page, Character dan Paragraf.

6. Menu Table berisikan perintah-perintah yang berhubungan dengan table seperti  

menyisipkan dan menghapus table.

7. Menu Tools berisikan perintah-perintah yang berfungsi untuk membuat surat secara 
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masal, spellcheck Options, Customize.

8. Menu  Help  berisikan  link  ke  file  help,  check  for  update  dan  registration  dan  

informasi tentang versi yang sedang digunakan.

2.1.2. Toolbar

Gambar 2.2 Toolbar OpenOffice.org Writer

Berdasarkan  gambar  2.2  diatas  dapat  di  lihat  susunan  toolbar  pada  OpenOffice.org 

Writer.  Pada  posisi  paling  atas  adalah  standard  bar  yang  tampil  pada  setiap 

OpenOffice.org. Pada baris kedua yaitu formatting bar, toolbar ini tergantung kepada 

objek yang sedang aktif atau sedang dipilih.

2.2. Mengolah Dokumen

Fungsi utama OpenOffice.org writer adalah sebagai pengolah dokumen. Dokumen yang 

diolah dapat berupa dokumen baru, dokumen lama dan dokumen hasil impor file dari 

format yang berbeda.

2.2.1.Membuat dokumen baru

Langkah-langkah membuat dokumen baru adalah dengan cara:

1. Pilih menu File

2. Pilih New

3. Maka akan keluar beberapa pilihan untuk membuka dokumen baru

4. Pilih Text Document

5. Maka akan tampil dokumen baru

6
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6. Atau dapat dengan menekan dengan cara pintas CTRL+N

Gambar 2.3 Membuat dokumen baru

2.2.2. Membuka File

Untuk membuka file dokumen yang telah tersimpan kita dapat melakukan hal berikut:

1. Pilih menu File pilih Open pada menu File atau pada toolbar standar, tekan tombol 

Buka ,atau menu Berkas | Buka

Gambar 2.4 Menu Buka Dokumen
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2. Pilih folder tempat file yang akan dibuka tersimpan.

3. Setelah folder  aktif,  pada daftar nama-nama file akan terlihat file yang sudah  

disimpan sebelumnya.

4. Pilih file yang akan di buka dengan format odt, klik tombol buka.maka dokumen 

akan tampil pada jendela.

Gambar 2.5 Tampilan Kotak Dialog Buka Dokumen

2.2.3. Menyimpan Dokumen 

File dokumen yang telah dibuat dengan menggunakan Open Office Writer jika disimpan 

akan  memiliki  extensi  .odt  sebagai  defaultnya.  Jika  dibutuhkan,  dokumen  dapat 

disimpan  kedalam  format  Microsoft  Word,  html,  text  dan  format  lainnya.  Latihan 

berikut adalah untuk menyimpan dokumen sederhana yang sudah dibuat.

1. Klik Menu Berkas pilih save atau save as atau pada toolbar standar klik tombol save

.

8
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Gambar 2.6 Menu File-Save

2. Pada kotak Nama yang paling atas, ketikan nama dokumen yang akan disimpan. 

3. Klik Save untuk menyimpan dan menutup kotak dialog Simpan.

Gambar 2.7 Tampilan Kotak Dialog Penyimpanan Data

9
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2.2.4. Mencetak Dokumen

Setelah selesai menginput data di dokumen yang di ketik,  maka tugas terakhir yang 

harus dilakukan adalah mencetak dokumennya. Caranya adalah sebagai berikut:

1. Klik pada menu File

2. Pilih Print pada daftar menunya 

Gambar 2.8 Menu Cetak

3. Pada kotak dialog, pilih jenis printer yang akan digunakan 

4. Pada bagian pages, tentukan halaman yang akan dicetak 

5. Apabila dokumen yang akan dicetak perlu rangkap maka pada number of copy … 

isikan dengan jumlah yang diinginkan 

6. Klik Ok

Gambar 2.9 Kotak Dialog Cetak
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2.3.Memformat Dokumen

2.3.1. Page Setup

Page setup adalah pengaturan yang digunakan untuk mengatur halaman berupa ukuran 

kertas,  margin  dan  orientasi  kertas.  Langkah-langkah  pengaturan  tersebut  sebagai 

berikut :

1. Pilih Menu Format.

2. Pilih Page.

3. Maka akan tampil kotak dialog seperti di bawah ini.

Gambar 2.10 Mengatur Ukuran, Margin dan Orientasi 

Untuk paper format :

• Format, digunakan untuk memilih jenis kertas yang akan digunakan 

• Width, menentukan lebar kertas

• Height, menentukan tinggi kertas

• Orientation, menentukanorientasi kertas

Untuk margin :

• Left, untuk mengatur batas kiri kertas

• Right, untuk mengatur batas kanan kertas

• Top, untuk mengatur batas atas kertas

• Bottom, untuk mengatur batas bawah kertas

11
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2.3.2. Membuat Header dan Footer

Untuk menyisipkan header dan footer pada OpenOffice.org yaitu dengan cara :

Pilih menu insert kemudian pilih Header atau Footer.

1. Atau pilih menu Format Pilih Page.

2. Maka akan muncul kotak dialog Page Style.

3. Pilih tab Header untuk mengatur catatan kepala.

4. Pilih tab Footer untuk mengatur catatan kaki.

5. Beri  tanda  checkbox  pada  header  on  untuk  mengaktifkan  header  dan footer  on 

untuk mengaktifkan Footer.

Gambar 2.11 Format Header

Gambar 2.12 Format Footer

12
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2.3.3. Menyisipkan Keterangan Tambahan

2.3.3.1. Dengan menggunakan Header dan Footer

Pada dokumen yang bersifat resmi atau sebuah tulisan dari sebuah instansi, keterangan 

tambahan  biasanya  diletakkan  di  bagian  Header  atau  Footer.  Keterangan  tambahan 

tersebut bisa berupa nama lembaga, judul,  tanggal,  ataupun nomor halaman. Contoh 

seperti di bawah ini.

Gambar 2.13 Menyisipkan Keterangan Tambahan

Buka Dokumen

Bukalah dokumen yang akan diberi keterangan tambahan.

Menyisipkan Header

Anda bisa menyisipkan header dengan cara meng-klik Insert >> Header >> Default.

Maka ruang header akan tampil di bagian atas halaman.

Gambar 2.14 Menyisipkan Header

13
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2.3.3.2. Mengatur Teks Header

Ketikkan keterangan yang akan dijadikan sebagai header. Ruang yang tersedia untuk 

header biasanya sempit. Jadi Anda perlu mengatur ukuran huruf agar bisa sesuai.

Gambar 2.15 Menyisipkan Teks pada Header

2.3.3.3. Menyisipkan Footer

Selain menyisipkan header, Anda juga bisa menyisipkan footer dengan cara yang tidak 

jauh berbeda. Klik menu Insert >> Footer >> Default.

2.3.3.4. Teks Otomatis

OpenOffice.org Writer menyediakan teks otomatis yang bisa Anda manfaatkan untuk 

header dan footer. Klik menu Insert >> Fields dan pilih item yang akan digunakan untuk 

footer. 

2.3.3.5. Page Style

Selain dari menu Insert, Anda juga bisa mengatur header dan footer melalui Page Style. 

Klik menu Format >> Page dan pilih tab Header atau Footer.

14
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Gambar 2.16 Page Style Header

2.4. Penomoran Halaman

Langkah-langkah untuk menyisipkan nomor halaman pada dokumen yaitu :

1. Header atau Footer harus sudah ada pada dokumen.

2. Tempatkan kursor pada Header atau Footer.

3. Kemudian klik menu Insert 

4. Pilih Field

5. Pilih Page Number

Gambar 2.17 Penomoran Halaman
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2.5. Pengaturan Paragraf

2.5.1. Merapikan Paragraf

Untuk merapikan paragraf pada dokumen adalah sebagai berikut :

1. Blok paragraf yang akan dirapikan.

2. Pilih menu Format.

3. Pilih Paragraph.

4. Pilih tab Alignment.

5. Untuk pengaturan teks pada paaragraf tersedia jenis perataan dengan memilih pada 

tulisan Option kemudian Left, Right, Center atau Justify.

6. Kemudian pilih Ok.

Gambar 2.18 Merapikan Paragraf

2.5.2. Mengatur Jarak antar Baris

Untuk mengatur jarak antar baris ikuti langkah-langkah dibawah ini :

1. Pilih menu Format.

2. Pilih Paragraph.

3. Pindahkan tab Indent & Spacing

16
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Gambar 2.19 Mengatur Jarak antar Baris

4. Pilih pengaturan line spacing untuk mengatur jarak antar barisnya yang mempunyai

 pilihan single, 1,5 lines, double, propotional, at laest, leading atau fixed.

5. Untuk mengatur  indentasi  pada paragraf  bisa diatur  pada bagian Indent.  Dengan 

mengisi nilai jarak pada masing-masing field pada before text dan after text sesuai 

dengan kebutuhan.

6. Pada Spacing bisa digunakan untuk mengatur jarak antar spasi paragraf.  Isi nilai 

pada Above paragraph dan Bellow paragraph.

7. Kemudian pilih Ok untuk menutup kotak dialog Paragraph.

2.6. Format Huruf

2.6.1. Memilih Tipe Huruf

Untuk  mempercantik  dokumen  salah  satunya  adalah  menentukan  tipe  huruf  yang 

dipilih. Untuk memilih tipe huruf dengan cara :

1. Pilih menu Format.

2. Pilih Character .
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Gambar 2.20 Kotak Dialog Character

3. Pilih tipe huruf dan ukuran huruf pada tab Font.

4. Kemudian tekan tombol Ok.

2.6.2. Membuat Efek pada Karakter

Untuk lebih memperindah karakter, dapat ditambahkan dengan cara sebagai berikut :

1. Pada kotak dialog Character pilih tab Font Effect.

Gambar 2.21 Tab Font Effect

2. Pilih effect sesuai dengan yang dibutuhkan, kemudian klik Ok.
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2.7. Membuat Daftar dengan Bulets & Numbering

Kita bisa memanfaatkan Bullets dan numbering untuk membuat sebuah daftar maupun 

susunan  kegiatan  dengan  rapi.  Anda  bisa  menggunakan  urutan  angka,  huruf,  serta 

simbol dalam gaya pengurutannya.

2.7.1. Buat Daftar

Buatlah dokumen baru melalui OpenOffice.org Writer, lalu ketikkan item-item  secara 

berurutan  ke  bawah  pada  dokumen  tersebut.  Lalu  arahkan  kursor  ke  bagian  kiri 

dokumen dan sorot/blok semua teks.

Gambar 2.22 Daftar pada Dokumen

2.7.2. Aktifkan Bullets & Numbering

Klik tombol Numbering On/Off pada Object Bar untuk mengurutkan dengan angka atau 

klik  Bullets  On/Off  untuk  menggunakan  penanda  lain.  Anda  juga  bisa  membuat 

penanda sendiri.
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Gambar 2.23 Blok Daftar pada Dokumen

2.7.3. Mengatur Format Numbering

Untuk  mengatur  formatnya,  Anda  bisa  meng-klik  menu  Format  >>  Bullets  and 

Numbering sehingga muncul kotak dialog.  Klik tab Bullets  dan pilih salah satu dari 

yang tersedia di dalam kotak tersebut.

Gambar 2.24 Kotak Dialog pada Tab Bullet

2.7.4. Menggunakan Simbol Grafis

Apabila  Anda  ingin  menggunakan  simbol  lain,  pilih  tab  Graphic.  Di  sini  tersedia 
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beraneka grafik warna-warni. Pilih yang Anda sukai.

Gambar 2.25 Kotak Dialog pada Tab Graphic

2.7.4. Model Penomoran

Jika  Anda ingin  menggunakan model  penomoran (angka amupun huruf),  Anda bisa 

memilih  tab  Numbering  type.  Di  sini  terdapat  beraneka  model  penomoran  dengan 

menggunakan angka, huruf, serta angka romawi. Pilih yang sesuai kebutuhan Anda.

Gambar 2.26 Kotak Dialog Tab Numbering Type
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2.7.5. Mengatur Jarak

Jarak antara angka/simbol pada Bullets and Numbering dapat diatur dengan cara 

mengklik tab Position. Masukkan angka di kotak Numbering alignment, Aligned at dan 

Indent at. Setelah itu, klik tombol OK.

Gambar 2.27 Kotak Dialog Tab Position

2.8. Style

Style berupa kumpulan huruf atau pengaturan tampilan pada dokumen. Fitur-fitur pada 

style berupa : 

1. Paragraf : Format seluruh paragraf

2. Karakter : Format satu karakter atau lebih

3. Frame : Format frame untuk teks dan grafik

4. Page : Format struktur dokumen 

5. Numbering : Format number dan bullet

2.8.1. Memanfaatkan Style

Untuk menggunakan Style and Formatting dengan cara :

1. Pilih Format
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2. Pilih Style and formatting

3. Atau dengan menekan tombol F11.

4. Maka akan muncul kotak dialog seperti dibawah :

Gambar 2.28 Kotak Dialog Style and Formatting

5. Untuk memanfaatkan Style and Formatting bisa digunakan dengan cara :

a. Setiap melakukan pengetikan teks baru pilihlah Style yang akan digunakan dari 

kotak dialog style and formatting.

b. Sedangkan untuk teks yang sudah ada,  diblok dulu teks yang akan di format 

kemudian pilih style and formatting yang akan digunakan.

2.8.2. Membuat Style Baru

Untuk membuat style baru ikuti langkah-langkah berikut iini :

1. Pada kotak dialog style and formatting klik kanan

2. Kemudian pilih new, maka akan muncul kotak dialog paragraph style.

3. Isi field name dengan nama style yang baru.

4. Kemudian Ok.
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Gambar 2.29 Membuat Style Baru

2.8.3. Memodifikasi Style

Untuk merubah dan mengatur style yang sudah ada dapat dengan cara :

1. Dari kotak dialog style and formatting klik kanan pilih modify.

2. Maka akan muncul kotak dialog Paragraphh style.

3. Pada kotak dialog style yang sudah dipilih akan dapat dirubah pada tab yang ada di 

kotak dialog. Tab yang ada pada kotak dialog style and formatting adalah Indent & 

Spacing, Alignment, Text Flow, Font, Font Effect, Position, Numbering, Tabs, Drop 

Caps, Background, Borders dan Condition.

4. Kemudian tekan Ok.

Gambar 2.30 Modifikasi Style
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2.9. Tables

2.9.1. Menyisipkan Table

Untuk menyisipkan tabel pada dokumen dengan cara :

1. Pilih menu Table.

2. Pilih Insert.

3. Pilih Table.

4. Kemudian akan muncul kotak dialog table.

Gambar 2.31 Kotak Dialog Table

4. Isi kotak dialog sesuai dengan kebutuhan.

5. Kemudian Ok.

2.9.2. Menambah Kolom

Untuk menambahkan kolom pada tabel yang sudah ada pada dokumen dengan cara :

1. Tempatkan kursor pada kolom yang akan ditambahkan.

2. Pilih menu Table.

3. Pilih Insert.

4. Pilih Column.

5. Tentukan jumlah dan posisi kolom yang akan disisipkan.

6. Kemudian klik Ok.
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Gambar 2.32 Kotak Dialog Insert Column

2.9.3. Menambah Baris

Untuk menambahkan baris pada tabel yang sudah ada pada dokumen dengan cara :

1. Tempatkan kursor pada kolom yang akan ditambahkan.

2. Pilih menu Table.

3. Pilih Insert.

4. Pilih Rows

5. Tentukan jumlah dan posisi kolom yang akan disisipkan.

6. Kemudian klik Ok.

Gambar 2.33 Kotak Dialog Insert Rows

2.9.4. Menghapus Kolom

Untuk menghapus kolom tertentu bisa dilakukan dengan cara :

1. Tempatkan kursor pada kolom yang akan dihapus, jika ingin menghapus lebih dari 

satu kolom blok sebanyak kolom yang akan dihapus.

2. Pilih menu Table.

3. Pilih Delete.
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4. Pilih Column.

2.9.5. Menghapus Baris

Untuk menghapus baris tertentu bisa dilakukan dengan cara :

1. Tempatkan kursor pada baris yang akan dihapus, jika ingin menghapus lebih dari 

satu baris blok sebanyak baris yang akan dihapus.

2. Pilih menu Table.

3. Pilih Delete.

4. Pilih Rows.

2.10. Merge dan Split

2.10.1. Merge

Cara menggabungkan kolom atau baris pada OpenOffice.org adalah dengan cara :

1. Pilih kolom atau baris yang akan digabungkan.

2. Pilih menu Table.

3. Pilih Merge Cells.

Gambar 2.34 Tabel Sebelum di Merge

Gambar 2.35 Tabel Sesudah di Merge
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2.10.2. Split

Cara memisahkan kolom atau baris pada OpenOffice.org adalah dengan cara :

1. Pilih kolom atau baris yang akan digabungkan.

2. Pilih menu Table.

3. Pilih Split Cells.

Gambar 2.36 Tabel Sebelum di Split

Gambar 2.37 Tabel Sesudah di Split

Perlu diingat pada saat proses pemisahan cell, harus merapikan kembali hasil dari split. 

Karena cell yang sudah dipisahkan tidak sesuai dengan format cells yang ada diatas dan 

bawahnya.

2.11.Formula

Cara  menghitung  formula  pada  OpenOffice.org  dengan  menggunakan  tabel.  Ikuti 

langkah-langkah berikut :

1. Tempatkan kursor pada bagian kolom atau baris untuk tempat jumlah.

2. Kemudian pilih menu Table.

3. Pilih Formula.

4. Maka akan muncul toolbar untuk menginput rumus.

28



Bab II OpenOffice.org Writer

Gambar 2.38 Toolbar Input Formula

No. Nama Nilai 1 Nilai 2 Nilai 3 Jumlah

1 Asih 70 70 70 210

2 Indah 80 80 80 240

3 Sakra 75 75 75 225

4 Somat 90 90 90 270

5 Lisdah 85 85 85 255
Gambar 2.39 Daftar Nilai

2.12.Menyisipkan Gambar

Dalam memasukan gambar ke word lebih baik menggunakan metode from file daripada 

copy-paste.  Hal  ini  untuk  mencegah  kekacauan  atau  gambar  tidak  muncul  ketika 

dokumen dibuka di komputer lain. Tahap memasukan gambar adalah :

1. Pilih menu Insert.

2. Pilih Picture.

3. Pilih From File.

Gambar 2.40 Menu Insert Picture
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4. Kemudian akan muncul kotak dialog untuk insert picture.

Gambar 2.41 Kotak Dialog Insert Picture

5. Kemudian pilih gambar yang akan dimasukan lalu klik Open.

2.13. Mengekspor Dokumen ke Format PDF

Dokumen pada OpenOffice.org dapat disimpan dan diekspor ke beberapa format. Salah 

satunya adalah format file PDF. Langkah-langkah untuk menyimpan file dalam format 

PDF adalah :

1. Pilih menu File.

2. Pilih menu Export.

3. Maka akan muncul kotak dialog seperti dibawah ini

Gambar 2.42 Kotak Dialog Ekspor Format File ke PDF
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4. Kemudian klik Save.

2.14. Membuat Kolom

Seperti  aplikasi  pengolah kata pada umumnya, OpenOffice.org Writer memiliki fitur 

untuk mengatur  kolom pada sebuah halaman dokumen.  Fitur  ini  berguna jika  Anda 

ingin memiliki dokumen dengan layout seperti surat kabar atau majalah. Agar tampilan 

kolom jadi lebih menarik, Anda bisa menambahkan garis pembatas tiap kolomnya.

2.14.1. Menentukan Kolom

Bukalah  dokumen  yang  akan  dibuat  menjadi  kolom-kolom.  Anda  bisa  mem-blok 

tulisan/paragraf  yang  akan  dibuat  kolom  atau  membuat  kolom  sebelum  mengetik 

dokumen. Setelah paragraf di-blog, klik menu Format >> Columns.

Menentukan Jumlah Kolom

Setelah kotak dialog Columns muncul, Anda bisa menentukan jumlah kolom yang akan 

digunakan dalam dokumen melalui kotak Column.

Gambar 2.43 Menentukan Kolom pada Dokumen

2.14.2. Mengatur Lebar Kolom

Setelah Anda memilih salah satu model kolom, Anda juga bisa mengatur lebar kolom 

secara manual. Hilangkan tanda centang pada bagian AutoWidth dan atur lebar masing-

masing kolom beserta jarak antar kolom.
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Gambar 2.44 Mengatur Lebar Kolom

2.14.3. Memberi Garis Pembatas

Bagian Separator line berfungsi untuk memberikan garis pembatas antar kolom. Jika 

Anda tidak menginginkannya, pilih None. Kotak Height berguna untuk mengatur tinggi 

garis pembatas. Kotak Position untuk menentukan posisi garis di dalam kertas.

Gambar 2.45 Menentukan Garis Pembatas Kolom
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2.14.4. Preview

Setelah pengaturan selesai, klik OK untuk menerapkan hasilnya. Untuk melihat hasilnya 

secara menyeluruh, klik menu File >> Page Preview.

Gambar 2.46 Preview Hasil Pemformatan Kolom

2.15. Membuat Label Alamat

Dalam mengerjakan tugas  perkantoran,  sering kali  kita  membuat  banyak surat  yang 

tentunya  dengan  alamat  yang  berbeda-beda.  Misalnya,  surat  pemberitahuan  tentang 

pajak pegawai yang dikirimkan ke masing-masing pegawai yang alamat rumahnya tidak 

mungkin sama.

Anda bisa mengerjakan hal tersebut secara otomatis dan mudah dengan OpenOffice.org, 

berikut ini langkah-langkahnya.

2.15.1. Siapkan Sumber Data

Jika Anda belum memiliki berkas yang berisikan data alamat, Anda bisa membuatnya 

dengan menggunakan OpenOffice.org Spreadsheet.
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Gambar 2.47 Sumber Data

Jika  Anda  sudah  pernah  membuatnya,  Anda  perlu  menghubungkan  berkas  alamat 

tersebut menjadi database pada dokumen yang akan Anda kerjakan.

Bukalah OpenOffice.org Writer, pilih menu File >> Wizard >> Address Data Source. 

Setelah itu akan muncul kotak dialog Address Book Data Source Wizard. Pilihlah Other 

External Data Source dan klik Next.

Gambar 2.48  Kotak Dialog Address Book Data Source Wizard

Anda akan diarahkan kepada kotak dialog konfigurasi Data Source. Klik Setting dan 

akan  muncul  kotak  dialog  Create  Address  Data  Source.  Pilih  Spreadsheet  dan  klik 
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tombol Next.

Gambar 2.49  Kotak Dialog Create Address Data Source

Muncul kotak dialog baru yang berfungsi untuk meletakkan alamat berkas alamat yang 

sudah Anda buat. Silahkan klik Browse dan pilih berkas alamat Anda. Untuk menguji 

apakah berhasil koneksi ke berkas Anda, klik Test Connection. Setelah itu klik Finish.

Gambar 2.50 Test Conection

Langkah  selanjutnya  adalah  mencocokkan  Field  Standar  Address  Book  milik 

OpenOffice.org dengan daftar alamat yang sudah Anda buat.

Klik  Field  Assignment,  setelah  itu  akan muncul  kotak  dialog  Address  Data  –  Field 

Assignment. Lihat dan coccokkan bagian Field assignment sesuai dengan daftar alamat 
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Anda. Setelah itu klik tombol OK.

Gambar 2.51 Kotak Dialog Address Data – Field

Silahkan Anda tuliskan nama untuk data source ini. Dan klik Finish.

Gambar 2.52 Data Source List

2.15.2. Membuka/Melihat Data Source

Setelah  kembali  ke  halaman  dokumen  OpenOffice.org  Writer,  Anda  bisa  meng-klik 

menu View >> Data Sources. Nanti di bagian atas, akan terlihat data source yang sudah 

Anda buat.
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Gambar 2.53 Melihat Data Source List

2.15.3.Ubah ke Ukuran Amplop

Halamat  standar  /  default  dari  OpenOffice.org  Writer  memiliki  ukuran  A4.  Untuk 

kebutuhan ini, Anda perlu merubahnya menjadi ukuran amplop dengan cara mengklik 

menu Insert >> Envelope sehingga muncul kotak dialog Envelope.

Gambar 2.54 Pengaturan Amplop
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2.15.4. Mengetikkan Alamat

Pada kotak dialog Envelope, arahkan kursor Anda ke bagian Addressee dan ketikkan 

alamat tujuan Anda. Misal :

Kepada :

Yth. Bapak Somat

Jl. Gajah Mungkur No. 16 Pekalongan

Kode Pos 34567

Gambar 2.55 Pengisian Address pada Amplop

2.15.5. Memilih Database

Arahkan  kursor  ke  sebelah  kanan  dan  klik  menu  drop-down  Database.  Pilih  nama 

database yang telah Anda buat sebelumnya. Pada opsi Table, ganti menjadi Sheets1 dan 

ubah pilihan Database field menjadi Nama.
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Gambar 2.56 Memilih Database

2.15.6.Memasukkan Database

Blok bagian nama di Adressee dan klik tombol panah. Bagian nama di adressee tersebut 

akan ditimpa dengan teks <Buku Alamat.Sheet1.0.Nama>. Rubah Database field dan 

ganti dengan Alamat. Blok bagian alamat pada Adresse dan klik tombol panah. Bagian 

alamat  pada  addresse  akan  ditimpa  dengan  teks  <Buku  Alamat.Sheet1.0.Alamat>. 

Lakukan juga untuk bagian-bagian lainnya sampai selesai.

Gambar 2.57 Memasukkan Database
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2.15.7. Memasukkan Alamat Pengirim

Anda dapat menuliskan alamat pengirim dengan cara mencentang bagian Sender dan 

menuliskan alamat pengirim di kotak yang terletak tepat di bawahnya.

Gambar 2.58 Memasukkan Alamat Pengirim

2.15.8. Mengatur Margin

Klik tab Format dan aturlah margin posisi  alamat pengirim dan alamat tujuan. Pilih 

ukuran amplop dari kotak drop-down Format. Umumnya, ukuran amplop adalah DL.

Gambar 2.59 Mengatur Margin

2.15.9. Memilih Layout

Klik tab Printer dan aturlah posisi amplop ketika dicetak dengan printer. Ada enam
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pilihan  layout  alur  kertas.  Sebaiknya  cobalah  menggunakan  kertas  A4  yang  Anda 

potong seukuran amplop terlebih dahulu.

Gambar 2.60 Memilih Layout

2.15.10. Menerapkan Format Amplop

Setelah  pengaturan  selesai,  maka  Anda  perlu  meng-klik  tombul  Insert  atau  New 

Document. Pada dokumen yang tampil di layar monitor telah berganti dengan format 

kertas amplop.

Gambar 2.61 Mengatur Format Amplop
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2.15.11. Menambah Bingkai

Untuk mempercantik tampilan amplop, Anda bisa menambahkan bingkai pada alamat

tujuan.  Klik  ikon  Show  Draw  Functions  sehingga  muncul  Toolbar  Drawing.  Klik 

Rectangle atau Basic Shape, lalu buatlah sebuah kotak tanpa warna dasar (invisible).

Gambar 2.62 Menambahkan Bingkai

2.15.12. Cetak Amplop

Apabila  template  amplop telah  siap  digunakan,  maka cobalah  mencetaknya terlebih 

dahulu. Masukkan sebuah amplop ke printer. Lalu klik menu File >> Print sehingga 

muncul  kotak  dialog.  Cobalah  mencetak  1  lembar  terlebih  dahulu.  Klik  Yes  untuk 

mencetak.

Gambar 2.63 Mencetak Amplop
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2.15.13. Simpan Dokumen

Klik menu File >> Save untuk menyimpan.

2.16. Menyimpan Dokumen dengan Password

Password  digunakan  untuk  melindungi  dokumen  yang  disimpan  oleh  pengguna  pc 

ataupun jaringan. Pada OpenOffice.org Writer password digunakan sebagai pelindung 

dokumen agar orang lain tidak berhak untuk melihat isi dokumen yang disimpan. Untuk 

menyimpan dokumen dengan password, langkahnya sebagai berikut :

1. Pada saat dokumen akan disimpan pilih menu File | Save atau File | Save as, beri 

tanda check box [v] pada pilihan save with password.

2. Ketik nama dokumen yang akan di simpan, kemudian tekan tombol Save, akan  

muncul kotak dialog pengisian password. Isi password  kemudian klik Ok.

3. Untuk mencoba dokumen yang di  password,  tutuplah  dokumen yang disimpan  

dengan password tersebut dan bukalah dokumen itu kembali. Kemudian masukkan 

password  yang  diminta  sesuai  dengan  password  yang  diketik  pada  saat  

penyimpanan dokumen. Password jangan sampai lupa!!!

Gambar 2.64 Simpan dokumen dengan password
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2.17. Mail Merge

Mail merge adalah fasilitas writer untuk membuat surat secara masal. Dengan fasilitas 

ini akan sangat membantu apabila pengguna writer ingin mengirim surat yang isinya 

sama namun tujuannya berbeda.

Dengan menggunakan mail  merge  lebih  mudah dan lebih  cepat  untuk mengirimkan 

surat  dengan  jumlah  yang  banyak  dan  tidak  memerlukan  banyak  waktu  untuk 

mengerjakannya.

Langkah-langkah menggunakan mail merge :

1. Membuat address list/data source. Pada OpenOffice data source disebut juga sebagai 

address list. Address list dapat dibuat dengan berbagai macam tipe file, baik berupa 

database maupun dengan spreadsheet.

2. Membuat dokumen utama. Pada OpenOffice dokumen utama disebut juga sebagai 

“starting document”. 

3. Setelah menyiapkan data source dan dokumen utama kita dapat memulai mail merge 

dengan memilih menu Tools > Mail merge wizard

Gambar 2.65 Menu Mail Merge

4. Maka  akan  muncul  kotak  dialog  dengan  beberapa  pilihan  untuk  menentukan 

dokumen utama yang dijadikan sebagai halaman utama dokumen. Pada contoh kali 

ini, dokumen yang digunakan adalah dokumen yang telah dibuat sebelumnya yaitu 
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undangan.odt. Pilih “start from existing document” kemudian klik tombol “browse” 

untuk menentukan posisi dokumen yang telah tersimpan sebelumnya.

Gambar 2.66 Pilih Dokumen

1. Kemudian klik next.

2. Maka akan muncul dokumen yang sudah dipilih dan klik next. Seperti gambar 

dibawah ini :

Gambar 2.67 Dokumen yang Dipilih

3. Pada menu jendela selanjutnya adalah tahap memasukkan alamat  (insert  address 
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block).  Pada  tahap  ini  terdiri  dari  beberapa  langkah  yaitu  memilih  data  source, 

menentukan format “address block”, menyesuaikan field yang diinginkan dengan 

data, memerikasa dan melihat hasil yang diinginkan. Berikut langkah-langkahnya :

• Langkah  pertama  adalah  dengan  memilih  data  source  yang  telah  kita  miliki 

sebelumnya dengan meng-klik tombol “select different address list”.

Gambar 2.68 Select Different Address List

• Kemudian akan muncul kotak dialog seperti dibawah ini :

Gambar 2.69 Add Database

• Kemudian klik  add untuk menambahkan database,  maka  akan muncul  kotak 

dialog seperti dibawah ini :
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Gambar 2.70 Pilih Database

• Kemudian klik open.

• Maka akan muncul kotak dialog untuk memilih field-field database yang telah 

dibuat. Untuk menentukan format alamat yang akan ditampilkan klik “more”.

Gambar 2.71 Pilih Model Address List

• Kemudian akan diberikan pilihan type address list  atau membuat  address list 
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yang baru dengan meng-klik new. Setelah memilih address list kemudian klik 

Ok. Maka akan kembali  ke kotak dialog sebelumnya.  Kemudian pilih  match 

fields untuk menyamakan field-field yang sudah dipilih. Seperti gambar dibawah 

ini :

Gambar 2.72 macth address list

• Klik ok

• kemudian lihat hasil yang telah dibuat sebelumnya. Apabila dirasa belum sesuai 

dapat mengulangi langkah-langkah sebelumnya, namun apabila dirasa sudah pas 

silahkan klik next.

• Pada  menu  selanjutnya  adalah  menentukan  dokumen  yang  diinginkan  juga 

mengandung salutation/pembuka seperti yang terhormat, yang tercinta, dan lain- 

lain.  Anda  dapat  dapat  menentukan  apakah  ingin  menggunakan  kalimat 

pembuka atau tidak. Jika tidak cukup hilangkan tanda checklist yang ada pada 

jendela dialog :
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Gambar  2.73 Salutation

• Menu  selanjutnya  yaitu  menentukan  posisi  kertas  yang  akan  dicetak/layout. 

Silahkan menentukan layout sesuai dengan keinginan anda.

Gambar 2.74  Tampilan yang akan dicetak

1. Sebelum  mencetak  dokumen  akan  ada  menu  pilihan  untuk  mengedit  dokumen 

utama yang ada, namun apabila tidak cukup klik next.

Gambar 2.75 Edit Dokumen

2. Menu berikut adalah untuk membuat halaman khusus halaman mail merge. Apabila 

tidak memiliki halaman khusus yang diinginkan selanjutnya klik next.
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Gambar 2.76 Halaman Khusus

3. Langkah  terakhir  adalah  mencetak  dokumen.  Dapat  mencetak  dalam bentuk  file 

perhalaman atau langsung mencetak ke kertas.

Gambar 2.77 Print Halaman

2.18.Menyisipkan Orientasi Halaman yang Berbeda

Adakalanya dalam pembuatan dokumen berisikan data yang disajikan dengan bentuk 

format  halaman  yang  berbeda.  Misalnya  pada  halaman  pertamanya  dengan  format 

default yaitu potrait. Kemudian halaman berikutnya adalah format landscape. Berikut 
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adalah  langkah-langkah  untuk  mengatur  halaman  dokumen  dengan  orientasi  yang 

berbeda :

1. Pilih Insert.

2. Pilih Manual Break.

3. Maka muncul kotak dialog Insert Break.

4. Pilih Style Landscape halaman untuk yang disisipkan.

5. Pilih Ok.

Gambar 2.78 Insert Break

Gambar 2.79 Tampilan Halaman yang Berbeda 
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2.19. Menyisipkan  halaman menggunakan Manual Break

Langkah-langkah menyisipkan halaman :

1. Pilih Insert

2. Pilih Manual Break

3. Pilih Type dengan pilihan : Line break, Column break, page break

4. Pilih Style dengan pilihan : Default, envelope, first page, footnote, index, left page,  
right page atau page style yang dibuat sendiri.

Gambar 2.80 Menu Insert – Manual Break
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BAB III

OPENOFFICE.org CALC

3.1. Antar Muka OpenOffice.org Calc

OpenOffice.org  Calc  adalah  aplikasi  spreadsheet  seperti  Microsoft  Excel.  Ketika 

pertama kali menggunakan Anda tidak akan menemukan banyak perbedaan dalam segi 

tampilan. Berikut antar muka OpenOffice.org Calc.

Gambar 3.1 Antarmuka Calc

Keterangan :

1. Menu :  Menu  sistem  operasi,  dalam  gambar  ini  menggunakan  sistem  operasi  

Ubuntu

2. Operasi File : Load, Save dan Save As.

3. Export as PDF : Untuk menjadikan dokumen menjadi file PDF.
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4. Spellcheck : Untuk mengecek ejaan dengan fitur Check As You Type.

5. Cut, Copy, Paste : Fasilitas untuk menyalin objek.

6. Undo dan Redo : Tombol yang berguna ketika Anda melakukan kesalahan dan ingin 

mengembalikan ke operasi sebelumnya.

7. Sort : Untuk mengurutkan teks atau serangkaian angka dari atas ke bawah atau  

sebaliknya.

8. Navigasi : Tool OpenOffice.org yang paling umum, mencakup Zoom dan Help.

9. Text Formatting : Menu untuk memilih font dan style untuk teks yang telah dipilih.

10. Justification : Untuk mengatur justifikasi teks dan angka dalam beberapa pilihan.

11. Number Format : Format umum untuk angka, mata uang dan desimal.

12. Range Selection : Untuk memilih lokasi sel, baris atau kolom serta untuk mencari 

seleksi sebelumnya.

13. Function  Wizard :  Panduan  untuk  membuat  sebuah  formula  dengan  sebuah  

function.

14. Cell Content : Sel di lembar utama yang menunjukkan sejumlah nilai, namun area 

ini akan menunjukkan function yang dimasukkan di dalam sel yang bisa diubah di 

kotak ini.

15. Column : Kolom spreadsheet. Dimulai dari kolom A sampai dengan kolom IV.

16. Row :  Baris  spreadsheet.  Ditunjukkan  dengan  angka.  Ukuran  dapat  diperbesar  

dengan cara men-drag garis batasnya.

17. Cell : Sel berisi angka atau teks yang dapat diatur menurut style tertentu.

18. Sheet Tab : Secara standar ada tiga sheet yang tersedia untuk setiap dokumen. Klik 

kanan untuk menambah lembar baru atau untuk mengubah namanya.

19. Status Bar : Berisi keterangan mengenai ukuran tampilan, sum, serta average.

3.2. Mengaktifkan OpenOffice SpreadSheet

Untuk menjalankan aplikasi openoffice spreadsheet, anda bisa melakukannya dengan 

meng-klik menu utama Aplikasi | Perkantoran | OpenOffice.org Spreadsheet. Kemudian 

aplikasi openoffice spreadsheet akan dijalankan oleh komputer, kemudian akan tampil 

jendela antar muka OpenOffice.org Spreadsheet seperti yang terlihat pada gambar.

54



Bab III OpenOffice.org Calc

Gambar 3.2 Lembar Kerja Calc

3.3. Mengetahui Cara Menyimpan File

Pada  OpenOffice.org  Spreadsheet  banyak  mendukung  berbagai  format  dokumen 

spreadsheet yang bisa anda gunakan, diantaranya format Microsoft  Exel 2000 (.xls), 

Data Interchange Format (.dif), dBASE (.dbf), .xml, dan lain sebagainya.

Untuk melakukan penyimpanan dokumen spreadsheet yang telah anda buat, ada 2 cara 

yang bisa anda gunakan, yaitu:

1. Menggunakan Ikon SAVE pada Menu Bar.

2. Menggunakan menu Berkas -> Save.

Lebih detail mengunaan Ikon SAVE adalah sebagai berikut:

a. Dengan mengklik ikon SAVE  pada MenuBar.

b. Kemudian akan muncul jendela dialog, seperti pada gambar dibawah ini.

Gambar 3.3 Kotak Dialog Save
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(a) Pada kolom “Name”: isikan nama berkas yang anda inginkan.

(b) Simpan ke  dalam folder  :  ini  tempat  dimana berkas  anda akan disimpan,  

secara default opsi ini akan menunjuk ke dalam folder /home/documents,  

tetapi anda bisa mengubahnya dengan mengklik opsi “Lihat folder lainnya”.

(c) Jenis Berkas: opsi ini bisa anda gunakan untuk memilih berkas yang telah  

anda buat ingin disimpan dalam format apa.

c. Setelah semua opsi anda tentukan sesuai dengan keinginan anda, tekan “Simpan” 

untuk menyimpan berkas anda.

Cara lain untuk penyimpan berkas spreadsheet melalui menu Berkas | Simpan (seperti 

yang terlihat pada gambar), kemudian lakukan cara seperti yang telah disebutkan diatas.

Gambar 3.4 Menu Save

3.4. Mengetahui Cara Membuka File

Ada beberapa cara yang bisa anda lakukan untuk membuka berkas spreadsheet, berikut 

ini cara untuk membuka berkas spreadsheet:

1. Buka aplikasi OpenOffice.org Spreadsheet dari menu Aplications | Office | 

OpenOffice.org Spreadsheet.

2. Kemudian klik menu  File |  Open, atau anda bisa menggunakan  shortcut papan  

ketik dengan menekan tombol “CTRL+O”. 

56



Bab III OpenOffice.org Calc

Gambar 3.5 Menu Open 

3. Selain itu anda juga bisa menggunakan ikon Open pada menubar.

4. Kemudian akan muncul kotak dialog Open (seperti pada gambar), pilih berkas yang 

spreadsheet yang ingin anda buka.

Gambar 3.6 Kotak Dialog Open 
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3.5. Mengetahui Cara Menjumlah Lajur

Untuk menjumlah jalur pada spreadsheet, ikuti cara-cara berikut:

1. Buat data numerik/angka yang akan dihitung, bisa per-kolom ataupun per-baris.

2. Kemudian di sel lain ketikan peritah berikut:

=SUM(bilangan1,bilangan2,...)

dimana bilangan1 adalah letak dimana sebuah angka/data numerik pertama diletakan 

(seperti pada gambar).

Gambar 3.6 Menghitung Lajur

3. Kemudian tekan tombol “ENTER” pada papan ketik anda.

3.6. Mengetahui Cara Mencetak Dokumen atau Berkas

Pencetakan  berkas  di  OpenOffice.org  Spreadsheet  cukup  mudah,  berikut  ini  cara 

melakukan pencetakan dokumen:

a. Buka berkas spreadsheet yang akan anda cetak

b. Klik menu File | Print, anda juga bisa menggunakan shortcut papan ketik dengan 

menekan tombol CTRL+P.
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Gambar 3.7 Menu Print

c. Kemudian  akan  muncul  kotak  dialog  Print,  yang  berfungsi  untuk  melakukan  

pengaturan halaman yang akan dicetak.

Gambar 3.8 Kotak Dialog Print

Ada beberapa opsi dalam gambar kotak dialog Cetak diatas, diantaranya:

a) Pencetak :  opsi ini adalah pengaturan mesin pencetak anda, jika anda mengklik  
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tombol  Properti,  akan  muncul  kotak  dialog  pengaturan  Kertas  yang  akan  

digunakan, dan pengaturan perangkat mesin pencetak lainnya.

b) Cetak : opsi ini digunakan untuk mengatur pencetakan lembar kerja anda, ada 3 sub 

opsi dari opsi Cetak ini:

(a) Semua Lembar: jika anda memilih opsi ini maka mesin pencetak akan mencetak 

semua sheet yang ada pada berkas spreadsheet anda.

(b) Lembar Terpilih:  jika opsi  ini  dipilih,  mesin pencetak hanya akan mencetak  

lembar kerja pada sheet yang aktif.

(c) Sel Terpilih: opsi ini digunakan jika anda hanya ingin mencetak pada sel yang 

anda seleksi/pilih.

c) Jangkauan cetak :  opsi ini digunakan untuk seberapa banyak halaman yang  

harus dicetak oleh mesin pencetak. Ada 2 sub opsi yang bisa anda gunakan:

(a) Semua halaman: jika opsi ini dipilih mesin pencetak akan secara otomatis 

mencetak semua halaman pada berkas spreadsheet anda.

(b) Halaman: anda juga bisa menentukan secara manual seberapa banyak 

halaman yang harus dicetak oleh mesin pencetak, dengan menggunakan opsi 

ini.

d) Rangkap : opsi ini digunakan untuk apabila anda ingin mencetak beberapa kali 

cetakan pada berkas spreadsheet.

d. Atau  anda juga  bisa menekan ikon “Cetak Langsung” pada menu bar.  Jika anda 

menggunakan cara ini, dokumen spreadsheet anda akan secara langsung dicetak tanpa 

anda melakukan pengaturan-pengaturan yang diperlukan saat pencetakan.

3.7. Menambah dan Menghapus Kolom atau Baris

3.7.1. Menambah Kolom atau Baris

Untuk Menambah kolom atau baris dengan cara :

1. Klik menu Insert.

2. Pilih Columns atau Rows.

3. Atau bisa dengan menggunakan menu melayang dengan meng-klik kanan pada  

mouse.

4. Pilih Insert Columns atau Insert Rows.
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Gambar 3.9 Menu Insert Columns atau Insert Rows

Gambar 3.10 Klik Kanan Insert Colums atau Klik Kanan Insert Rows

3.7.2. Menghapus Kolom atau Baris

Untuk menghapus kolom atau baris dengan cara :

1. Klik kanan untuk menampilkan menu melayang pada kolom atau baris lembar 

kerja.

2. Pilih Delete Columns atau Rows.
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Gambar 3.11 Klik Kanan Delete Columns atau Delete Rows

3.8. Formula

Formula adalah operasi matematika untuk mendapatkan hasil dari perhitungan data pada 

range  sel  data  dengan  operator  matematika.  Rumus  formula  dioperasikan  dengan 

diawali tanda sama dengan (=).

Membuat formula :

1. Klik pada sel dimana hasil dari formula akan ditampilkan.

2. Ketik tanda sama dengan (=).

3. Contoh : Formula untuk menampilkan hasil penjumlahan sel A1 dan A2, formula  

yang dibuat pada sel : =A1+A2

4. Kemudian Enter.

Operator Aritmatika

Operator Nama Contoh

+ (Plus) Addition 3+5

- (Minus) Subtraction

* (Asterisk) Multliplication 3*3

/ (Slash) Division

% (Percent) Percent 30.00%

^ (Caret) Exonentiation 7^2
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3.9. Fungsi Vlookup dan Hlookup

3.9.1. Fungsi Vlookup

Fungsi Vlookup digunakan untuk membaca tabel data yang disusun secara tegak lurus 

(vertikal). Bentuk umum dari fungsi Vlookup adalah :

=Vlookup(Sel kunci, Range Tabel, Offset Kolom)

Sel Kunci adalah kolom yang menjadi kunci dalam pembacaan tabel data. Range tabel 

adalah daerah yang disorot (range) pada tabel pembanding. Offset kolom adalah kolom 

yang akan dibaca pada tabel data.

Seperti pada gambar dibawah adalah contoh dari tabel penggunaan rumus Vlookup :

Gambar 3.12 Tabel Vlookup

3.9.2. Rumus Hlookup

Fungsi Hlookup digunakan untuk membaca tabel data yang disusun secara mendatar 

(horizontal). Adapun bentuk umum Hlookup adalah :

=Hlookup(Sel Kunci, Range Table, Offset Baris). Offset baris adalah baris yang akan 

dibaca pada tabel data.

Seperti pada gambar dibawah adalah contoh dari tabel penggunaan rumus Hlookup :
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Gambar 3.13 Tabel Hlookup

3.10. Format Angka

Untuk memformat angka pada OpenOffice.org dengan cara :

1. Sorot angka yang akan diformat.

2. Pilih Format Cells.

3. Maka akan muncul kotak dialog Cells.

Gambar 3.14 Kotak Dialog Format Cells

4. Pilih kategori angka sesuai kebutuhan.Gambar 3.14 Kotak Dialog Cells
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3.11. Membuat Grafik

Dalam  membuat  dokumen  spreadsheet,  kadang  kala  Grafik  atau  Chart  sangatlah 

bermanfaat untuk menerjemahkan angka-angka menjadi sesuatu yang visual dan mudah 

dimengerti. Grafik juga dapat mudah menarik perhatian pembacanya.

3.11.1. Siapkan Data

Sebelum memulai  membuat  grafik,  persiapkan data  yang akan Anda buat  grafiknya 

terlebih dahulu. Ada baiknya data tersebut terangkum dalam satu kolom atau baris dari 

pada tersebar berserakan. Anda juga perlu untuk mengurutkan data tersebut sehingga 

nantinya hasil grafik juga akan terlihat lebih rapi.

3.11.2. Memberi Label

Beri  label  masing-masing  data  yang  ada  di  kolom spreadsheet.  Chart  wizard  dapat 

mengambil label dari kolom dan baris yang Anda buat. Pastikan saat menyeleksi baris 

dan kolom, bagian label tersebut ikut terpilih. Jika label tidak ikut terpilih, nanti grafik 

tidak akan memunculkannya.

Gambar 3.15 Memberi Label

3.11.3. Memilih Range

Pilih  range (area)  yang  akan  digunakan  untuk  grafik  dengan  cara  meng-klik  dan 

mendrag sel sehingga terseleksi semua. Anda juga bisa mengedit  range dengan cara 

mengetik  nilai  pada  text  field.  Untuk  memilih  range,  Anda  ketik  nama  atau 

menggunakan menu drop down.

65



Bab III OpenOffice.org Calc

Gambar 3.16 Memilih Range

3.11.4. Chart Tool

Dengan posisi  range yang sudah terpilih, klik menu  Insert >>  Chart atau dari  Chart  

tool yang ada di toolbar. Selanjutnya akan terbuka kotak dialog Chart Wizard. Sebuah 

grafik akan muncul di belakang kotak dialog. Tidak perlu khawatir akan ukuran grafik 

tersebut jika dirasa terlalu kecil bagi Anda. Anda bisa memperbesar atau memindahkan 

ke lokasi yang lebih luas.

3.10.5. Tipe Grafik

Anda bisa memilih tipe grafik untuk menunjukkan data dalam spreadsheet. Jika data 

berupa penjualan barang dari sebuah toko misalnya, maka tipe bagan yang cocok adalah 

pie  (grafik  kue).  Data  berupa  nilai  penjualan  per  tahun  mungkin  lebih  tepat 

menggunakan  grafik  bar,  sementara  pergerakan  profit  di  pasar  modal  lebih  cocok 

menggunakan bagan Candlestick. Setelah itu tekan tombol Next.
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Gambar 3.17 Memilih Tipe Grafik

3.11.6. Konfirmasi

Bagian  kedua  di  dalam  Chart  Wizard adalah  menanyakan  data  range yang  akan 

digunakan  dalam  grafik.  Apabila  Anda  telah  menentukan  data  tersebut,  seharusnya 

nilainya telah muncul di  data range. Kini Anda hanya perlu mencontreng kotak  First  

raw as label dan  First  column as label apabila Anda ingin menyertakan label pada 

grafik.

Gambar 3.18 Data Range
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3.11.7. Judul Grafik

Langkah berikutnya adalah memberikan judul grafik, sub judul dan melabeli sumbu X 

ataupun sumbu Y dari grafik. Pada sesi ini juga Anda diminta menentukan letak dari 

legenda grafik.

Gambar 3.19 Memberi Judul Grafik

3.11.8. Menerapkan Grafik

Setelah Anda atur  semua kebutuhan grafik tersebut,  Anda tinggal  meng-klik tombol 

Finish untuk menerapkan hasil grafik ke lembar kerja.

Gambar 3.20 Gambar Grafik
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3.10.9. Mengubah Grafik

Grafik tersebut seperti halnya objek lain. Anda bisa melakukan klik kanan pada grafik 

tersebut. Lalu akan muncul menu text dan pilih perintah yang ada.

Gambar 3.21 Mengubah Grafik

3.11.10. Memberi Warna Latar

Untuk memberi warna latar dari sebuah grafik, klik kanan grafik tersebut dan pilih Edit. 

Setelah itu klik kanan lagi dan pilih Object Properties.

Klik tab Area dan pilih warna untuk dijadikan sebagai warna latar grafik Anda.

Gambar 3.22 Memberi warna Background
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3.11.11. Menambahkan Gradasi

Klik kanan untuk memilih  Object Properties dan klik tab  Transparency. Di sini Anda 

bisa memilih model-model  transparency. Pilih  Gradient dan tentukan tipe gradasinya 

serta atur persentasenya.

Gambar 3.23 Menambah Gradasi

3.11.12. Efek 3D

Agar grafik terlihat lebih menarik, Anda bisa memberikan efek 3 dimensi. Klik kanan 

grafik dan pilih Chart Type. Beri tanda centang kotak 3D Look dan klik OK.

Gambar 3.24 Memberi Efek 3D
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3.11.13. Mengubah Elemen Grafik

Anda  bisa  meng-klik  ganda  pada  objek-objek  di  dalam  grafik  untuk  mengatur 

propertinya. Setelah di klik ganda, klik kanan dan pilih  Object Properties. Anda bisa 

mengatur jenis huruf, warna, serta ukuran.

Gambar 3.25 Mengubah Elemen Grafik

3.12. Fungsi Terbilang

Fungsi  terbilang  berfungsi  untuk  menguraikan  sejumlah  nilai  dari  perhitungan 

Langkah-langkah untuk menggunakan fungsi terbilang adalah sebagai berikut :

1. Jalankan OpenOffice.org Spreadsheet.

2. Pilih Tools

3. Pilih Macro

4. Organize maMacro

5. Pilih OpenOffice.org basic
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Gambar 3.26 Menu Tools – Macros

6. Pada kotak dialog openoffice.org basic pilih macro dari My Macro > Standard

7. Klik New

8. Maka akan muncul halaman editor, Isi halaman editor tersebut dengan kode dibawah 

ini :
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Gambar 3.27 Module Macros

Function Kekata(Bilangan as double) As String

Dim angka as variant

angka = Array("","satu","dua","tiga","empat","lima","enam",_

"tujuh","delapan","sembilan","sepuluh","sebelas")

Bilangan = abs(Fix(Bilangan))

If Bilangan<12 Then

Kekata = " " & angka(Bilangan)

Elseif Bilangan<20 Then

Kekata = Kekata(Bilangan - 10) & " belas"

Elseif Bilangan<100 Then

Kekata = Kekata(Fix(Bilangan/10)) & " puluh" & Kekata(Bilangan mod 10)

Elseif Bilangan<200 Then

Kekata = " seratus" & Kekata(Bilangan mod 100)

Elseif Bilangan<1000 Then

Kekata = Kekata(Fix(Bilangan/100)) & " ratus" & Kekata(Bilangan mod 100)

Elseif Bilangan<2000 Then

Kekata = " seribu" & Kekata(Bilangan mod 1000)

Elseif Bilangan<1000000 Then
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Kekata = Kekata(Fix(Bilangan/1000)) & " ribu" & Kekata(Bilangan mod 1000)

Elseif Bilangan<1000000000 Then

Kekata = Kekata(Fix(Bilangan/1000000)) & " juta" &_

Kekata(Bilangan- (Fix(Bilangan/1000000)*1000000))

Elseif Bilangan<1000000000000 Then

Kekata = Kekata(Fix(Bilangan/1000000000)) & " milyar" &_

Kekata(Bilangan- (Fix(Bilangan/1000000000)*1000000000))

Elseif Bilangan<1000000000000000 Then

Kekata = Kekata(Fix(Bilangan/1000000000000)) & " trilyun" &_

Kekata(Bilangan- (Fix(Bilangan/1000000000000)*1000000000000))

Else

Kekata = "Error! Input Tidak Dapat Diproses."

EndIf

End Function

Function Terbilang(Bilangan as Double, Optional Style as Integer) as String

Dim temp as String

If Bilangan<0 Then

temp = "Minus " & trim(kekata(Bilangan))

Else

temp = trim(kekata(Bilangan))

EndIf

If Style=1 Then

Terbilang = ucase(temp)

ElseIf Style=2 Then

Terbilang = lcase(temp)

ElseIf Style=3 Then

kata = split(temp)

l = LBound(kata)

u = UBound(kata)

For i=l to u

kata(i) = ucase(mid(kata(i),1,1)) & mid(kata(i),2)
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Next i

Terbilang = join(kata())

Else

Terbilang = ucase(mid(temp,1,1)) & mid(temp,2)

EndIf

End Function

9. Kemudian cobalah dengan memasukkan angka pada cell A1 kemudian masukkan 

rumus pada cell lainnya dengan cara :

=terbilang(cell;style) 

cell adalah kolom yang berisi bilangan yang akan diterjemahkan.

style adalah nilai integer yang sifatnya optional untuk mengatur output cara 

penulisan huruf besar atau kecilnya, dan jika tidak disertakan akan tampil huruf 

besar pada awal kalimat saja. 

Nilai Style dapat dilihat sebagai berikut:

1 = Ditulis huruf kapital (Uppercase) semua

2 = Ditulis huruf kecil semua

3 = Huruf kapital hanya pada awal kata saja

Lainnya = Huruf besar pada awal kalimat saja

Misalkan cell G1 berisi bilangan 375000, dan kita akan menuliskannya di cell H1, 

maka:

= terbilang(G1) menghasilkan: Tiga ratus tujuh puluh lima ribu.

= terbilang(G1;1) menghasilkan: TIGA RATUS TUJUH PULUH LIMA RIBU

= terbilang(G1;2) menghasilkan: tiga ratus tujuh puluh lima ribu

= terbilang(G1;3) menghasilkan: Tiga Ratus Tujuh Puluh Lima Ribu

Dan untuk menambahkan rupiah di akhir kalimat, cukup melakukan trik berikut:

= terbilang(G1;3) & " Rupiah" menghasilkan: Tiga Ratus Tujuh Puluh Lima Ribu 

Rupiah
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Gambar 3.28 Hasil Rumus Terbilang
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BAB IV

OPENOFFICE.org  IMPRESS

Openoffice.org  impress  adalah  modul  yang  disediakan  untuk  keperluan  membuat 

dokumentasi  presentasi.  Fitur  dan fungsi  yang ada pada impress kompatibel  dengan 

microsoft power point. Openoffice.org impress dilengkapi dengan fitur-fitur yang sangat 

baik dan menarik untuk presentasi.

4.1. Membuat presentasi baru

Setelah membuka impress, kotak dialog Presentation Wizard pada gambar 4.1 dibawah 

ini akan muncul. Jika tidak, klok File > Wizard > Presentation.

Gambar 4.1 wizard openoffice impress

● Dibawah Type, pilih salah satu dari pilihan-pilihan berikut:

1. Empty Presentation membuat presentasi dari awal.

2. From Template menggunakan sebuah desain template yang telah dibuat sebagai 

dasar bagi sebuah presentasi.

3. Open  Existing  Presentation  melanjutkan  pekerjaan  pada  presentasi  yang  telah 

dibuat sebelumnya.
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● Klik Next

Kotak dialog Presentation Wizard akan muncul:

1. Di bawah select a slide desaign, pilih desain, atau biarkan kosong, pilih 

<Original>

2. Pada Select an output medium, pilih bagaimana presentasi akan digunakan. Paling 

sering, presentasi dibuat untuk layar.

3. Klik Next.

Gambar 4.2 presentation wizard

4.2. Memodifikasi slide

Bila slide yang ada akan dihapus, tempatkan mouse di atas slide yang akan dihapus 

(pada bagian kiri layar). Kemudian tekan tombol Delete. Sedangkan untuk mengganti 

nama slide:

● Tempatkan mouse pada slide yang akan diganti namanya (pada bagian kiri layar) 

dan klik kanan, pilih Rename Slide.

● Pada kotak dialog Rename Slide, ketik nama baru slide pada field Name dan tekan 

tombol OK.
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Gambar 4.3 rename slide

Untuk menyusun ulang posisi urutan slide, pada area penyuntingan dokumen presentasi 

pindahkan ke tab slide sorter. Kemudian klik dan drag setiap slide yang dipindahkan ke 

urutan yang diinginkan.

Gambar 4.4 slide sorter

4.3. Menambahkan gambar

Ada bermacam-macam tipe gambar yang dapat ditempatkan dalam presentasi. Meng-

import  file  gambar atau  memilih  gambar-gambar yang telah dirancang dari  impress 

galeri.

● Meng-import gambar dari file

1. Pilih Insert > Picture > From File untuk mengakses jendela Insert Graphics.

2. Sorot dengan mouse file gambar yang akan diimport.

3. Klik open untuk menyisipkan ke dalam slide.
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Gambar 4.5 mengimport gambar

● Meng-import gambar dari galeri

Pada bagian ini akan dibahas bagaimana cara menyisipkan gambar dari galeri. Galeri 

adalah satu set gambar-gambar yang dirancang untuk membantu para pengguna untuk 

memilih grafik-grafik bagi presentasi.

1. Pilih Tools > Galerry

2. Obyek-obyek gambar berada di dalam gallery dan galerru theme box. Obyek- obyek 

gallery dapat diubah di dalam galerry theme box.

3. Klik dan drag objek yang dikehendaki dari galerry ke dalam slide yang sesuai.

4. Ketika  selesai,  klik  Tools  >  Galerry  kembali  untuk  menyembunyikan  galerry  

tersebut.

Gambar 4.6 toolbox gallery
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4.4. Mengubah latar belakang slide dan area

Untuk mengubah latar belakang slide:

5. Pilih Format > Page. Kotak dialog Page Setup akan muncul dengan dua tab, Page 

dan Background.

6. Klik tab Background, dan buat perubahan sesuai dengan yang dikehendaki.

7. Klik OK, sebuah kotak dialog akan muncul menanyakan “Background settings for 

all pages?”  klik Yes jika anda menginginkan latar belakang tersebut untuk muncul pada 

semua slide,  atau No jika anda menginginkan latar  belakang tersebut  hanya muncul 

pada slide yang dipilih.

Gambar 4.7 page setup

● Mengubah latar belakang area

Untuk mengubah latar belakang dari  sebuah area,  misalnya sebuah text atau sebuah 

bentuk:

1. Pilih area yang dikehendaki. Ketika dipilih, dia akan dikelilingi oleh sebuah kotak 

berwarna abu-abu berisi pengubah ukuran berwarna hijau.

2. Pilih  Format  >  Area.  Kotak  dialog  area  akan  muncul,  pilih  setting  yang  

dikehendaki.

3. Kemudian klik OK.
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Gambar 4.8 format area

4.5. Transisi antar slide dan efek animasi

Transisi-transisi slide menambahkan sebuah edge khusus pada sebuah presentasi dan 

memperhalus transisi antar tiap slide.

● Menambahkan efek transisi

1. Klik pada slide yang dikehendaki.  Transisi  muncul ketika slide menampilkan 

pergerakan pada slide ini.

2. Pada toolbox Slide Transition terdapat pada bagian Task di bagian kanan layar. 

Pilihlah jenis transisi yang ingin digunakan.

3. Modifikasilah transisi slide yang meliputi kecepatan dan suara.

4. Tekan tombol Apply to All Slide.

5. Tekanlah tombol Play atau Slide Show untuk mencoba efek yang diberikan.
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Gambar 4.9 slide transition

● Menambahkan efek animasi

Setiap objek pada presentasi dapat diberi efek animasi yang dapat dinikmati saat slide 

show. Untuk menggunakannya ikuti langkah berikut ini:

1. Klik objek yang akan diberi efek animasi.

2. Dari toolbox Custom Animation yang terletak di Task pada bagian kanan layar, 

klik tombol Add dan akan muncul kotak dialog Custom Animation.

3. Atur efek animasi yang ingin diterapkan pada objek. Efek animasinya meliputi  

Entrance,  Emphasis,  Exit,  dan  Motion  Path  yang  terletak  pada  tab  masing-

masing.

4. Tekan tombol OK.

5. Pada toolbox Efect Animation dapat diatur lagi mulainya efek animasi, arah, dan 

kecepatannya (Start, Direction dan Speed).
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Gambar 4.10 efect animation

Gambar 4.11 custom animation
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4.6. Mengekspor tampilan slide sebagai format lain

Sayangnya,  tidak  semua  komputer  memiliki  perangkat  lunak  openoffice.org.  Itulah 

sebabnya terdapat beberapa pilihan yang membuat impress fleksibel dan dapat dilihat 

pada  platform  virtual  lain.  Ada  tiga  fasilitas  yang  secara  khusus  berguna  untuk 

memenuhi hal ini: pilihan export as PDF, shockware, dan HTML.

● Mengekspor ke file flash

Sebuah  format  file  flash  (yang  juga  disebut  shockware)  (.swf)  didasarkan  pada 

program flash, yang dibuat oleh macromedia. Untuk mengekspor sebagai sebuah file 

(.swf):

1. pilih File > Export.

2. Pilih lokasi dan nama bagi file tersebut.

3. Pada File Format, pilih Macromedia Flash (.swf).

4. Klik Save

● Mengekspor ke file HTML

HTML  atau  Hyper  Text  Markup  Language  diwakili  dengan  ekstensi  .htm. 

Menyimpan  presentasi  dalam  format  ini  memungkinkan  pengguna  untuk  meng-

upload  file-file  ini  ke  internet  sehingga  dapat  dilihat  sebagai  halaman  web. 

Karakteristik  penting  lainnya  dari  format  ini  adalah  dapat  dilihat  oleh  berbagai 

macam platform aplikasi dan komputer.

Langkah-langkah untuk meng-export sebagai sebuha file HTML sebagai berikut:

1. Pilih File > Export.

2. Pilih lokasi dan nama bagi file tersebut.

3. Pada File Format, pilih HTML Document (OpenOffice.org Impress)(.html;.htm).

4. Jendela HTML Export akan muncul. Ini adalah panduan yang akan membantu 

anda melakukan setup pada dokumen HTML tersebut.  Ikuti  panduan tersebut. 

Jika masalah muncul, gunakan pilihan default, yang umumnya bekerja dengan 

baik ketika menyimpan dalam format ini.

5. Klik Create untuk mengakhiri proses ini.
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Gambar 4.12 mengekspor dokumen presentasi ke html
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